


Table
Design
Guidelines

In the Beginning Course, you learned how to create and modify
simple tables. When doing this, little attention was given to the
quality of your table design. In order to develop and work with
more complex databases, it is important to have an understanding
of considerations that should be made when designing a table.

In this lesson, you are going to investigate some of these table
design considerations. Keep in mind, however, that the guidelines
discussed are not unique to Access — they apply to most Relational 
Database Management Systems (RDBMS).

1. Start Access.

2. On the Getting Started task pane, choose More. (If
the task pane is not displayed, you can use
CTRL/F1 to display it.) Alternatively, you may
simply choose Open on the File menu.

The Open dialog box appears.

3. On the Open dialog box, 
use the Look in box 
to navigate to the 
FLS Access2003 Student Files folder on the C drive.

Note: If the FLS Access2003 Student Files folder does
not ap pear on the C drive, ver ify that you in stalled
the stu dent files ac cord ing to the steps be gin ning on
page vi.

4. Open the Design database file.

5. If a Security Warning alert box appears as shown
below, click Open.

This alert box informs you that opening untrusted
databases could expose you to viruses or other
computer security threats. Because your student
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files are from a trusted source, you can safely open
them.

The Database window appears.

Note: In the list box of the Open di a log box, your
file names might con tain a pe riod fol lowed by a
three char ac ter ex ten sion, such as mdb. In fact, all file
names con tain an ex ten sion. Win dows has an
op tion, how ever, that al lows you to hide some of
these ex ten sions. It does not mat ter if the ex ten sion
is hid den " De sign is the same file as De sign.mdb. In
this course, we will usu ally re fer to a file with out
indicating its extension.

Avoid
Repeating
Fields

A table has repeating fields when there are fields of a record that
contain (basically) the same type of information. You will look at
an example of a table with repeating fields and then discuss some
of the problems with it.

1. On the Database window, verify that the Tables tab 
is selected.

2. Double-click the RepeatingFields table to open it in
Datasheet view.

3. If necessary, use the horizontal scroll bar to view
the fields on the right side of the table.

Notice that each record has multiple fields for
different courses and grades. Since these multiple
fields hold what is essentially the same information,
they are considered repeating fields.
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A problem with repeating groups becomes clear if
you look at the last two fields of the table, Course5
and Grade5. These fields hold the course number
and grade of a fifth class, but not every student takes 
five classes per semester. Since they are part of the
table, however, every record must contain these two
fields. This is inefficient table design.

4. You are going to look at a table that corrects some of
these problems.

Close the RepeatingFields table.

5. Open the NotRepeatingFields table.

Notice the table.

This table contains the same information as the
RepeatingFields table, without the repeating fields.
The repeating fields were eliminated by using a
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single field for the course name (i.e., Course) and a
single field for the grade (i.e., CourseGrade). Each
class that a student takes is entered as a separate
record in the table.

Although this table design solves the problem of
repeating fields, it creates other problems. In
particular, there is a lot of duplicate information in
the table. For every course grade, the StudentID,
Name, Grade, and HomeRoom fields must be entered.
This is inefficient table design. As you will learn, a
better solution is to break the table into two tables — 
one to hold student information and the other to
hold course and grade information for the students.

6. Close the NotRepeatingFields table.

Break Down
Large Tables

When designing a database, you might be tempted to put all of the
information in a single table. Although this might seem to make the 
most sense, it can cause problems at a later time, especially when
you need to add, delete, or modify records. You are going to look
at a large table and then discuss ways to make it smaller.

1. Open the LargeTable table.

Notice the table datasheet.

2. Scroll the datasheet and notice the different fields.

Although tables can contain a large number of
fields, the variety of fields in this table is not
recommended, for it can make updating your
database difficult. For example, suppose the advisor
named Stover were replaced by someone named
Thompson. Since this table is the only place where the 
Advisor field is stored, you would have to locate
every student who has Stover as an Advisor and
replace the field with Thompson. Even with the help
of the Find and Replace commands, this could be
tedious if you have many records in the table.

Lesson 1 - Relational Database Design 5



A better solution for this table would be to break it
up into smaller tables, with each table containing
related information. For example, you could break
this table into four smaller tables: PersonalInfo (to
hold student’s address and guardian information),
HomeRooms (to hold homeroom assignments for
teachers), Advisors (to hold advisor names), and
Attendance (to hold attendance information).

3. You are going to look at two smaller tables that could
be created from the LargeTable table.

Close the LargeTable datasheet.

4. Double-click the HomeRooms table to open it.

Notice that this table contains only two fields:
HomeRoom and HRTeacher. To link this information
to another table, you could create a relationship,
which you will do in Lesson 3. With the data broken
up into smaller tables, it is easier to update the
database if a homeroom teacher changes " you only 
need to change one record in
this table.

5. Close the HomeRooms table.

6. You are going to look at another
smaller table that could be
created from the larger one.

Open the Attendance table.

7. Scroll the table and notice how the records are
organized.

When a student is late or absent, a new record is
added to the table. Notice that the table contains
only the three fields
necessary to indicate
that a student is absent 
or late: the StudentID
(which is unique), the
date of the incident,
and a field indicating
if the student was late
or absent.

Since the StudentID
field is unique, you
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can use this field to create a relationship between
this table and the StudentPersonal table, allowing you 
to match the StudentID with the name and address
of the student.

8. Close the Attendance table.

Always Use a
Primary Key

As you learned in the Beginning Course, a primary key field is a
field (or combination of fields) that uniquely identifies each record
in a table. Examples of primary key fields would be a field that
stores Social Security numbers (for the United States) or product
part numbers (for a company).

Primary key fields are very important when setting up a
relationship between tables. You are going to look at examples of
primary key fields in different tables.

1. Open the StudentPersonal table.

Once again, the primary key field should be unique
for each record in the table. This excludes most of
these fields for consideration as a primary key field.
Although one might be tempted to use the Name
field as a primary key, it is not difficult to imagine
two students with the same name, which would
mean that the field is not unique for every record.

Unlike the other fields in the table, the StudentID
field changes with every record. This makes it an
ideal candidate for the primary key.

2. You can see which field is the primary key field by
switching to Design view.

On the View menu, choose Design View.

The Table Design window appears. In the top pane,
notice the small key icon next to the StudentID field
name.       This indicates that the field is the primary
key field 
for the table.
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Note: To make a field the pri mary key field, se lect
the field in the Ta ble De sign win dow and then
choose Pri mary Key on the Edit menu.

3. Close the StudentPersonal Table Design window.

4. Open the HomeRooms table.

5. On the View menu, choose Design View.

In the top pane, notice that the HomeRoom field has
been designated as the primary key field. 

Of course, this assumes that each room number is
the homeroom of only one teacher. Since no two
room numbers are the same, each record in this table 
will be unique.

Note: If a sin gle room is shared by more than one
homeroom teacher, you could cre ate a third field for
the ta ble and set it as an AutoNumber data type.
Since AutoNumber fields in crease au to mat i cally
with each new re cord, this field would be unique.

6. Close the Table Design view window.

If necessary, you can also designate a combination of two or more
fields to be primary key fields. You are going to look at an example
of this type of primary key.

1. Open the Attendance table.

2. Scroll through the table and notice the values in
each record.

Individually, none of the three fields in the table
would be an appropriate primary key field — they
will all need to be duplicated at some point. If you
look at the StudentID and the Date field as a pair,
however, this combination would be unique for each 
record. (For a given date, a particular student can be
either late or absent, never both. Therefore, the
combination of the StudentID and the Date will be
unique for each record.)
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3. You are going to set the StudentID and the Date fields
as the primary key for the table.

On the Table Datasheet toolbar, click the
View button.

You are switched to Design View.

4. In order to set a combination of two or more fields at
the primary key, they must both be selected.

In the top pane, point to the very left of the
StudentID field, until the pointer
turns into a horizontal arrow
pointing to the right.

5. Drag down until both the
StudentID and the Date rows are selected.

6. On the Edit menu, choose Primary Key.

7. Click in a row to remove the highlight.

Notice that small key icons
appear next to the StudentID
and Date fields. This
combination has been set as
the primary key for the table.

8. On the File menu, choose Save to save the changes
to the table design.

9. Close the Table Design window.

Field Design 
Guidelines

Just as there are guidelines that should be followed when
designing and organizing tables, there are guidelines that should
be followed when you create fields. You are going to look at some
examples of good and bad field design.

Store
Information
in Logical
Parts

Although it might seem easier to put a lot of information in a single 
field, this can prevent you from gaining full access to the
information in the database at a later time. You are going to look at
an example of a field that contains too much information.

1. Open the StudentPersonal table.

You already used this table as an example of a table
that was created by breaking up a larger table.

Lesson 1 - Relational Database Design 9



Within this table, however, there are fields that
could be broken up into smaller logical parts.

Notice that the second field in the table, the Name
field, is used to store both the first and the last name
of the student. You are going to see why this is not
normally a good field design.

2. By default, records in this table are sorted by StudentID. 
You are going to sort them alphabetically by name.

Click an insertion point anywhere in the second
column of the table.

3. On the Records menu, point to Sort.

4. On the submenu, choose Sort Ascending.

Notice that the records are now sorted in ascending
order by the Name field. Since the first name of the
student appears first in this field, the records are in
fact sorted by student first name.

It would be very difficult to sort the records by last
name, which is a more common type of sort. A
better solution for this field would be to break it up
into two separate fields, one called FirstName and a
second called LastName. This smaller (but still
logical) grouping of the fields would allow you not
only to sort records by the last names of the
students, but also use the first and last names
independently of each other in reports.

Note: In the same vein, you might con sider break ing 
up the Par ent/Guard ian field into first and last names, 
as well as the Street field into Street1 and Street2 (for
an apart ment num ber).

Relate Fields
to the
Primary Key

When creating the fields for your table, you should make sure that
every field relates directly to the primary key of the table. This
helps to keep all fields of the table centered around one subject (the 
primary key).
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1. Verify that the StudentPersonal table is open.

As you might remember, the primary key field for
this table is the StudentID field. As a result, every
field in this table should be directly related to the
student.

2. Use the horizontal scroll bar to scroll to the right of 
the table.

Notice that most of the first few fields of the table
are directly related to the StudentID field. In
particular, the Name, Street, City, State, Zip, and
Parent/Guardian fields all describe something about
the StudentID field.

The first field in the table that is not directly related
to the StudentID field is the GuardianWork field. This
field is about the student’s guardian, not the
student. The same holds true for the WorkAddress,
WorkCity, and WorkPhone fields. Since these fields do 
not relate directly to the primary key of the table, it
would be best to put them in a Guardian table. In
turn, you would create a relationship between the
StudentPersonal and the Guardian table.

Avoid Fields
that Can be
Calculated

As you will learn later, Access can perform calculations on fields.
For example, Access can find the sum, product, or average of two
or more fields. For this reason, it is best to avoid using fields that
can be calculated when you set up your tables.

1. Verify that the StudentPersonal table is open.

2. Use the horizontal scroll bar until you can see the
DOB and the Age fields.
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Clearly, the age of a student depends upon the
student’s date of birth. This is a calculation that
Access can perform readily. Rather than store the
student’s age in a table, then, it is better to have
Access use the date of birth and the current date to
perform the calculations whenever needed — for a
report or a query, for example. You will learn how to 
create calculation fields in Lesson 6.

In the same manner, notice the TotalCredits field.
This field is also the result of a calculation — namely 
the sum of the credits for every class that the student 
has taken. Rather than update this field manually
each semester, it is best to create a calculation field
in a query and have Access do the work for you.

3. Close the StudentPersonal table without saving
changes.

Normalizing
Tables

The guidelines for table and field design that you have investigated 
in this lesson are formalized in a process called normalization. When 
you normalize the data in your database, you eliminate duplicate
information in tables, which makes it easier to manage and change
your database in the future. Normalization typically involves
dividing large tables into smaller ones. These smaller tables are
then connected using relationships. 

Normalization has five different levels. These levels are also called
forms. Each form corresponds to a different set of “rules” about
how the data in the table is organized. Most of the rules correspond 
to guidelines that have been discussed in this lesson. Since most
professional database developers use the terms discussed below,
however, it is worthwhile to be familiar with them.

The five different levels of normalization are as follows:

! First Normal Form. This requires that each field contains
the smallest logical value and that no table contains
repeating fields.
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! Second Normal Form. This concerns tables that have a
multiple-field primary key. In these tables, each
non-primary key field should relate to all parts of the
primary key — not just one part of the primary key.

! Third Normal Form. This concerns tables that have a
single-field primary key. In these tables, all other fields
should relate directly to the primary key field.

! Fourth Normal Form. Tables in this form do not have
many-to-many relationships (which you will use in
Lesson 3) between the fields of the table.

! Fifth Normal Form. Fifth normal form occurs when all
tables have been broken down into the smallest possible
tables in order to eliminate redundant non-key fields.

Creating an
Index

As mentioned, it is important that every table contain a primary
key field. Although not as essential, it is also a good idea to create
an index for each table. Just as you use the index in a book to locate 
topics quickly, Access uses the index for a table to speed searches
and other database operations. 

You are going to create an index for the StudentPersonal table.

1. Open the StudentPersonal table in Design view.

As you recall, the primary key for this table is the
StudentID field. If you are using this table to look up
student information, however, it is more likely that
you will do a search based on one of the other fields
— perhaps the student name, grade, or advisor.
Creating an index for one of these fields can help
speed searches, especially when the table contains
many records.

2. You are going to create an index for the Advisor field.

In the top pane, click an insertion point in the
Advisor row to select the field. (You may need to
scroll the list.)

3. Tap F6 to switch to the Field Properties pane.

You will learn about the different field properties in
the next lesson. For now, notice the Indexed option at 
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the bottom of the pane. By default, most fields are
not indexed.

4. Click an insertion point in the Indexed box and then 
tap F4 to display the drop-down list box.

Notice the three
options available.

No is the default.

Yes (Duplicates OK) will create an index that allows
duplicate values.

Yes (No Duplicates) will create an index that does not
allow duplicate values.

5. The Advisor field is not unique for each record, so you
must allow for duplicates.

Choose Yes (Duplicates OK).

You have created an index for the Advisor field. You
have not changed the order of the records, you have
simply designed the table so that searching for
records based on the Advisor field will be quicker. 

Note: If you end a field name with ID, Ac cess sets
the in dexed prop erty to Yes (Du pli cates OK)
au to mat i cally.

6. Save changes to the table design.

Note: You can not in dex a field whose data type is
Memo or OLE Ob ject.

Viewing
Indexes

A table can have more than one field indexed. You can use the
Indexes dialog box to view all of the indexes for a table.

1. On the View menu, choose Indexes.
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The Indexes dialog box appears. Notice the indexes
for the table, including the one that you just created.

Each index is defined by four parts:

Index Name. By default, the name of the index is the
same as the name of the field being indexed. An
exception to this is the index that is created for the
primary key field. This index is given the name
PrimaryKey.

Field Name. This is the name of the field being
indexed. You can select the field from a drop-down
list box that appears when you enter the Field Name
column.

Sort Order. By default, this is set to Ascending. This
affects only the order of the index, not the actual
records in the table.

Index Properties. Every index contains three
properties, which are listed in the bottom pane. The
Primary property indicates if the index is the
primary key. The Unique property indicates if each
index entry must contain unique values. The Ignore
Nulls property indicates if records that do not
contain any value in the indexed field should be
excluded from the index.

2. Click an insertion point in the PrimaryKey index
name to select it.

Notice the properties for the PrimaryKey index.

Note: Ac cess in dexes the pri mary key field
au to mat i cally.

3. Close the Indexes dialog box by clicking the
Close box.

Note: You can cre ate as many as thirty-two in dexes
for each ta ble ob ject in a da ta base.
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Creating a
Multiple-Field 
Index

If a particular field value occurs in many records, it might make
sense to create an index from a combination of fields, particularly
in tables with many records. This is similar to what is done in a
book's index. If you were to look up the topic Relationships in this
book's index, you would find references to a number of other
sub-topics, such as defining, editing and one-to-one. These sub-topics
help you to find what you need more quickly than if only
Relationships were listed.

You are going to create a multiple-field index that uses the State
and the City fields. Although this would not be needed for this
particular table (every student is from New York), it would
certainly be appropriate in other cases.

1. You must use the Indexes dialog box to create a
multiple-field index.

Verify that the StudentPersonal table is in Design
view.

2. Instead of the menu command, you will use the toolbar 
button.

On the Table Design toolbar, click the
Indexes button.

The Indexes dialog box appears.

3. Click an insertion point in the Index Name box of
the first empty row.

4. Type: Location

Note: When naming an index, it is best to choose a
name that re minds you of its pur pose. In ad di tion,
the in dex names should be unique for each ta ble.

5. Tap the TAB key to move to the Field Name box.

6. Tap F4 to display the available fields.

7. When creating a multiple-field index, you should start
with the “broadest” field — the field that will contain
the greatest amount of duplicate data.

In the Field Name drop-down list box, choose State.

By default, Ascending is chosen in the Sort Order
column.

8. So far, the Location index is based on a single field. To
make it based on more than one field, simply enter a
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field name in the next row without entering anything in 
the Index Name box.

Tap the DOWN ARROW key to move to the Field
Name box of the next row.

9. Tap F4 to display the drop-down list box and then
choose City.

By entering more than one Field Name for a single
Index Name, you have created a multiple-field index.

Note: Each mul ti ple-field in dex can in clude up to
ten fields.

10. The individual fields are not indexed.

Verify that the insertion point is in the City field.

Notice that there are no index properties listed in the 
bottom pane. Since the City field is part of a multi-
field index, it does not have individual properties.

11. Click an insertion point in the State field.

Notice the index properties.

They always appear when
the row that contains the
index name is selected.

Note: Of the thirty-two al low able in dexes for each
ta ble, only five can be mul ti ple-field in dexes.

Deleting an
Index

You can delete an index by setting the Indexed field property to No
or by using the Indexes dialog box. You are going to delete the
Advisor index that you created earlier.

1. At the left of the Indexes dialog box, point to the
row selector for the Advisor index.
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2. Right-click.

The row is highlighted and
a Shortcut menu appears.

3. On the Shortcut menu,
choose Delete Rows.

The index is removed from the dialog box. Deleting
an index does not delete any data from the table.

4. Close the Indexes dialog box.

5. Save changes to the table design.

6. Close the StudentPersonal window.

Review
Exercise

To review the concepts presented in this lesson, you are going to
design a new table to store students who have a learning disability. 
A reason for doing this might be to keep this information
confidential, so that it is not readily available to those who use the
LargeTable table. After you create the new table, you will create an
index for the Attendance table.

1. The Design database should be open.

2. With the Tables tab selected, click the New button
and then choose to create your table in Design
View.

3. Use the Table Design window to create the
following fields (you can indicate your own
description):

Field Name Data Type Field Size
StudentID Number Long Integer
Category Text 10
LastReview Date/Time

4. Set the StudentID field as the primary key field.

5. Index the table using the Category field (allow
duplicates).

6. Save the table with the name SpecialEd.

7. Switch to Datasheet view and add the following
records:
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8. Close the datasheet.

9. Open the Attendance table in Datasheet view.

10. A common search on this table would be for students
who were late or absent on a particular day.

Use the Indexes dialog box to create a multi-field
index using the Date and Attendance fields. (Choose 
an appropriate name for the index.)

11. Save changes to the table design.

12. Close the database and exit Access.

End of Lesson 1
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